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CertifyMe - 70-178



Exam A

QUESTION 1
A section of your project contains only a summary task along with four subtasks and a milestone. You
discover that the section is located in the incorrect phase and has the incorrect Work Breakdown Structure
(WBS) numbering. You need to move the section to another phase of the project. You also need to ensure
that the section reflects the correct WBS numbering. What should you do?

A. Select the summary task and change the scheduling mode to Manually Scheduled.
B. Select the entire section and click Move Task.
C. Drag the summary task.
D. Modify the start and finish dates of the summary task.

Correct Answer: C
Section: (none)
Explanation

Explanation/Reference:

QUESTION 2
You have a Project 2010 schedule that contains the following tasks:
     Inactive tasks
     Manually scheduled tasks
     Manually scheduled summary tasks
     Tasks that contain strikethrough font
You want to save the schedule as a Project 2007 project. You need to ensure that no new milestones are
created. What should you do?

A. Change all inactive tasks to active tasks.
B. Change all tasks that contain strikethrough font to tasks that include normal font.
C. Change all manually scheduled summary tasks to automatic scheduling.
D. Change all manually scheduled tasks to automatic scheduling.

Correct Answer: C
Section: (none)
Explanation

Explanation/Reference:
When a Project 2010 project is saved as a Project 2007 project, summary tasks that are manually
scheduled in Project 2010 are set to milestone tasks in Project 2007.

QUESTION 3
You manage several projects. Each project has shared resources and work distribution. You need to
ensure that you can adjust the workload for specific resources used across multiple project schedules.
What should you do?

A. Enable the Load Summary Resource Assignments option. Then, select the Level Resource function on
each project.

B. Open the individual schedules and use the Visual Reports option. Then, use the Resource Usage view
to manually modify resource Work.

C. Open a blank project and select Insert Subproject for each project schedule. Then, use the Level
Resource function for selected resources.

D. Open the shared Resource Pool for each project schedule. Then, use the Level Resources function.

Correct Answer: C
Section: (none)
Explanation

Explanation/Reference:



QUESTION 4
You manage a project that specifies all constraint types to As Soon As Possible. You discover that one of
your key tasks is scheduled to end prior to the targeted finish date. You need to display the targeted finish
date on the default Gantt chart. What should you modify in the Task Information window?

A. Set the Deadline date field.
B. Set the Constraint date field.
C. Set the Finish date field.
D. Select the Mark task as milestone check box.
E. Select the Display on Timeline check box.

Correct Answer: A
Section: (none)
Explanation

Explanation/Reference:
Deadline dates don't usually affect task scheduling. They are used to indicate a target date you don't want
to miss, without requiring you to set a task constraint that could affect scheduling if predecessor tasks
change. A task with a deadline is scheduled just like any other task.

QUESTION 5
The first major phase of your project is scheduled for a duration of 45 days. However, you do not have task
information for other phases. You need to indicate that the duration of the entire project is 200 days. What
should you do?
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A. Select the Project Summary Task option.
B. Select the Summary Tasks option.
C. Create a manually scheduled summary task.
D. Update the project calendar.

Correct Answer: C
Section: (none)
Explanation

Explanation/Reference:

QUESTION 6
The project you manage has only part-time resources. The part-time resources work four hours a day from
Wednesday through Saturday. You need to create a new calendar and set the calendar as the default for
your project. Which two actions should you perform? Each correct answer presents part of the solution.

A. Select the part-time calendar from the Change Working Time window.
B. Set the calendar type to part-time for all tasks.
C. Select the part-time calendar from the Project Information window.
D. On the Project tab, Select Change Working Time, and then click Create New Calendar.
E. Change the Calendar type in the Project Options dialog box.

Correct Answer: CD
Section: (none)
Explanation



Explanation/Reference:

QUESTION 7
You need to set the default constraint type for all new tasks to As Late As Possible. What should you do?

A. Select all tasks, and then click Layout.
B. In the Options dialog box, enable the New Tasks are effort driven check box.
C. Select all tasks, and then set the constraint type to As Late As Possible.
D. In the Project Information window, from the Schedule From drop-down list box, select Project Finish

Date.

Correct Answer: D
Section: (none)
Explanation

Explanation/Reference:
When scheduling from the Finish Date, Project automatically assigns the As Late As Possible (ALAP)
constraint to new tasks.

QUESTION 8
You manage a project according to the schedule as shown in the exhibit.



You need to set the Task Mode for task 4 to be the same as task 6. What should you do?

A. Create a task dependency from Task 4 to Task 6.
B. Set Task 4 as critical.
C. Add a 1 day lead to Task 4.
D. Set Task 4 as manually scheduled.

Correct Answer: D
Section: (none)
Explanation

Explanation/Reference:
The Gantt bar for task 6 indicates that it is a manually scheduled task.

QUESTION 9
You use bottom-up scheduling. You need to group four consecutive tasks in a major phase. You highlight
the four tasks. Which command should you use?

A. Outdent
B. Fill Down
C. Insert Summary



D. Move Task

Correct Answer: C
Section: (none)
Explanation

Explanation/Reference:

QUESTION 10
You need to view Task ID 0 on your project plan. What should you do?

A. On the Advanced tab of the Project 2010 options, select Show Status Bar.
B. On the Format tab, select Summary Tasks.
C. On the Format tab, select Project Summary Task.
D. Insert a new Summary Task.

Correct Answer: C
Section: (none)
Explanation

Explanation/Reference:

QUESTION 11
You have added two new tasks to your project. Both tasks are subtasks to a summary task. You need to
update Baseline1 only for the two new tasks. What should you do?

A. Highlight the two tasks.Click Set Baseline and select Baseline1.Click the Selected Tasks radio button,
select To all summary tasks, and then click OK.

B. Highlight the summary task.Click Set Baseline and select Baseline1.Click the Selected Tasks radio
button, select To all summary tasks, and then click OK.

C. Highlight the summary task.Click Set Baseline and select Baseline1.Click the Entire Project radio
button, and then click OK.

D. Highlight the two tasks.Click Set Baseline and select Baseline1.Click the Selected Tasks radio button,
and then click OK.

Correct Answer: A
Section: (none)
Explanation

Explanation/Reference:

QUESTION 12
You use Project Professional 2010 to manage a software development project as shown in the exhibit.



You need to cancel the 'Develop prototype based on functional specifications' task. You also need to retain
all the information from the task. Which two actions should you perform? Each correct answer presents part
of the solution.

A. Delete the task.
B. Set the tasks remaining work to 0 hours.
C. Inactivate the task.
D. Make the task 100 percent complete.
E. Create a link from the 'Develop functional specifications' task to the 'Review functional specifications'

task.

Correct Answer: CE
Section: (none)
Explanation

Explanation/Reference:

QUESTION 13
DRAG & DROP
You use Microsoft Project Professional 2010 to manage an engineering project according to the schedule
as shown in the exhibit. Originally, Adam Barr was assigned 75 percent units for 3 days. Adam worked for 8
hours on the first day and informed you that he needs an additional 9 hours of work to finish. You update
the schedule. What percentage of units should be reflected in the schedule by Adam's workload?



A. 75%, 75%
B. 75%, 100%
C. 100%, 100%
D. 100%, 150%

Correct Answer: A
Section: (none)
Explanation

Explanation/Reference:

QUESTION 14
You need to ensure that you can view only the tasks on your projects critical path. What should you do?

A. On the Advanced tab of the Project 2010 options, select the Calculate multiple critical paths check box.
B. View the projects Gantt chart and apply the Critical group.
C. View the project's Gantt chart and apply the Critical filter.
D. On the Advanced tab of the Project 2010 options, modify the Tasks are critical if slack is less than or

equal to option.

Correct Answer: C
Section: (none)
Explanation

Explanation/Reference:

QUESTION 15
The red person icon is displayed next to one of your tasks. You need to find out the reason for the display of
the icon. What should you do?

A. Display the task details.



B. Use the Level Resource feature.
C. Use the Task Inspector tool.
D. View the task information.

Correct Answer: C
Section: (none)
Explanation

Explanation/Reference:

QUESTION 16
One of your tasks in your project plan is 50 percent complete. The task has a finish variance of 4 days and
a work variance of -14 days. Which set of values describes the task?

A. The task is early by 14 days.
B. The task is early by 4 days.
C. The task is late by 4 days.
D. The task is late by 14 days.

Correct Answer: C
Section: (none)
Explanation

Explanation/Reference:

QUESTION 17
You enter the finish date for a task, and then assign a resource. You discover that the task is automatically
scheduled for two weeks past the finish date you have entered. You need to identify the problem. What
should you do?

A. Click Calculate project.
B. Use the Task Inspector tool and view the start and finish dates.
C. Use the Task Inspector tool and view the resource calendar.
D. View the deadline date for the task.

Correct Answer: C
Section: (none)
Explanation

Explanation/Reference:

QUESTION 18
Your project contains several baselines. By mistake, you save one of your baselines in Baseline5. You need
to move Baseline5 to Baseline3 while preserving the baseline information. You also need to create a new
Baseline5 by using today's data. Which two actions should you perform? Each correct answer presents part
of the solution.

A. From the Clear Baseline window, click Clear baseline plan and select Baseline3.
B. From the Clear Baseline window, click Clear baseline plan and select Baseline5.
C. From the Set Baseline window, click Set interim plan and copy Baseline5 into Baseline3.
D. From the Set Baseline window, click Set Baseline and select Baseline3.
E. From the Set Baseline window, click Set Baseline and select Baseline5.

Correct Answer: CE
Section: (none)
Explanation



Explanation/Reference:

QUESTION 19
You update your project schedule based on information received from your team members in today's status
meeting. You need to compare the current revised project schedule with the baseline schedule side by side.
Which default view should you use?

A. Calendar
B. Multiple Baselines Gantt
C. Leveling Gantt
D. Tracking Gantt
E. Timeline

Correct Answer: D
Section: (none)
Explanation

Explanation/Reference:

QUESTION 20
Your project contains many tasks that have dependencies and result in independent networks of tasks. You
need to ensure that you can view critical tasks on all independent networks of tasks within the project. What
should you do?

A. View the project's Gantt chart and apply the Critical filter.
B. On the Advanced tab of the Microsoft Project 2010 options, select the Calculate multiple critical paths

check box.
C. View the project's Gantt chart and apply the Critical group.
D. On the Advanced tab of the Microsoft Project 2010 options, modify the 'Tasks are critical if slack is less

than or equal to' option.

Correct Answer: B
Section: (none)
Explanation

Explanation/Reference:
You can calculate and display a critical path for each independent network of tasks within the project:

Click the File tab, and then click Options.
In the Project Options dialog box, click Advanced, and then select the Calculate multiple critical paths
check box.

By default, Project sets the late finish date for tasks without successors or constraints to be the project
finish date. If you choose to calculate multiple critical paths, Project sets the late finish date for these tasks
to be their early finish date, making the task critical.

QUESTION 21
You have team members who work on one of the following shifts: Monday through Friday: 8 hours a day.
Tuesday through Saturday: 10 hours a day. Sunday through Wednesday: 12 hours a day. You need to
ensure that your project plan accommodates the different shifts. What should you do?

A. Create shift resource departments.
B. Change the maximum units for each resource.
C. Create three tasks, one for each shift.
D. Create a base calendar for each shift.

Correct Answer: D
Section: (none)
Explanation



Explanation/Reference:

QUESTION 22
All tasks are assigned to multiple team members. A business analyst sends you an e-mail message that
contains the dates of her vacation. You need to modify the schedule to reflect delays that are caused only
by the business analysts vacation dates. What should you do?

A. Modify the start and end dates of all the tasks of the business analyst.
B. Create a new enterprise calendar, and then enter the vacation days.
C. Use the Mark on Track command.
D. Change the working time for the resource calendar of the business analyst.

Correct Answer: D
Section: (none)
Explanation

Explanation/Reference:

QUESTION 23
You need to create a new project schedule by using tasks from an existing project. You need to achieve
this goal without inheriting actual hours from the existing project. What would you do first?

A. On the File menu in Project 2010, use one of the existing templates.
B. Save the task list in Microsoft Excel and use the Project Import Wizard.
C. Open the previously saved project schedule and save it as a template.
D. Save the task list as a Microsoft Excel template.

Correct Answer: C
Section: (none)
Explanation

Explanation/Reference:
When you save a project as a template, you can remove baseline data, actuals, resource pay rates, fixed
cost information, and task publishing status.

QUESTION 24
You have a list of tasks in Microsoft Excel 2010. You need to create a Microsoft Project 2010 schedule that
maintains the order of the tasks. Which two actions could you perform? Each correct answer presents a
complete solution.

A. From Excel 2010, save the file by using the .mpp file extension.
B. From Project 2010, use the New from Excel workbook wizard.
C. From Project 2010, use the Open command and select the Excel file.
D. From Excel 2010, save the file by using the .mpt file extension.

Correct Answer: BC
Section: (none)
Explanation

Explanation/Reference:
From Excel 2010, you cannot save as .mpp or .mpt

QUESTION 25
You need to be able to send the custom Quick Access Toolbar to all users. What should you do?

A. Use the Reset all customizations option.
B. Use the Organizer tool.



C. Save the project as a Project 2010 template (.mpt) file.
D. Use the Export all customizations option.

Correct Answer: D
Section: (none)
Explanation

Explanation/Reference:
You can export your ribbon and Quick Access Toolbar customizations into a file that can be imported and
used by coworkers or on another computer.
Click the File tab. Under Help, click Options. Click Customize Ribbon. In the Customize the Ribbon window,
click Import/Export. Click Export all customizations.

QUESTION 26
You need to import a task list from a Microsoft Office SharePoint 2010 site to create a project schedule in
Project 2010. You need to achieve this goal while maintaining SharePoint synchronization. What should you
do?

A. Use the Save to SharePoint feature and type the URL that contains the task list.
B. Open the SharePoint task list in Datasheet view and copy the tasks to a blank project file.
C. Use the New from SharePoint feature and type the URL that contains the task list.
D. Save the SharePoint task list to a Microsoft Excel file and use the Project Import Wizard.

Correct Answer: C
Section: (none)
Explanation

Explanation/Reference:

QUESTION 27
You receive an e-mail message that contains a list of tasks. You need to create a new project schedule
from the list of tasks. What should you do first?

A. Open a previously saved Project 2010 file and save it as a blank template.
B. Create a list of tasks in Microsoft Excel, and save the file by using the .mpt file extension.
C. Create a new file in Project 2010 and paste the list of tasks.
D. Create a new template file in Project 2010.

Correct Answer: C
Section: (none)
Explanation

Explanation/Reference:

QUESTION 28
You need to ensure that when you add new tasks, the project schedule doesn't set a start date and end
date. What should you do?

A. Select Task from the main ribbon menu. Highlight the task that you want to change and select Manually
Schedule.

B. On the Schedule tab of the Project options, change the 'New tasks created' option to Manually
Scheduled.

C. On the Advanced tab of the Project options, clear the Automatically add new resources and tasks check
box.

D. On the Display tab of the Project options, clear the Edits to start and finish dates check box.
E. Click New Tasks and change the option to Auto Scheduled.

Correct Answer: B



Section: (none)
Explanation

Explanation/Reference:
When a task is in manually scheduled mode, the Start, Finish, and Duration columns can be blank.

QUESTION 29
Your project has a part-time resource who works 4 hours a day from Monday through Thursday. You need
to ensure that your project plan accommodates the part-time resource. What should you do?

A. Update the base project calendar.
B. Change the working time for the resource.
C. Change the maximum units for the resource.
D. Assign the resource only to tasks that are scheduled on the working days.

Correct Answer: B
Section: (none)
Explanation

Explanation/Reference:

QUESTION 30
Your project has Subject Matter Experts (SMEs) who are consulted for each task. You need to create a
single field that includes a list of SME names that can be associated with each task. What should you do?

A. Create a task custom field that includes a lookup table custom attribute.
B. Enter the list of SME names on the Resource tab of the Task Information window.
C. Create a project custom field that includes a lookup table custom attribute.
D. Create a resource custom field that includes a lookup table custom attribute.

Correct Answer: A
Section: (none)
Explanation

Explanation/Reference:

QUESTION 31
You want to print the Gantt Chart view of your project. You need to hide the Gantt chart legend. What
should you do?

A. Edit the view.
B. Edit the Bar Styles dialog box.
C. Edit the layout.
D. Edit the Page Setup dialog box.
E. Edit the Text Styles dialog box.

Correct Answer: D
Section: (none)
Explanation

Explanation/Reference:
In Page Setup, on the Legend tab, set 'Legend on' to 'None'.

QUESTION 32
You use Project Professional 2010 to manage a construction project. Different members of the project team
frequently modify a blueprint file. The file is saved in a Microsoft Office SharePoint document library. You
need to access the file from within the project schedule. What should you do?



A. Add a hyperlink.
B. Use the Links Between Projects tool.
C. Use the Sync with Tasks List feature.
D. Use the Save to SharePoint feature.

Correct Answer: A
Section: (none)
Explanation

Explanation/Reference:

QUESTION 33
The milestones in your project schedule represent the end of phases. You need to change the background
color of the cells of the milestones to blue. What should you do on the Format tab?

A. Select Text Styles, and then select Milestone Tasks.
B. Select Layout, and then select Show drawings.
C. Select Drawing, and then select Text Box.
D. Select Column Settings, and then select Milestone.
E. Select Bar Styles, and then select Milestone.

Correct Answer: A
Section: (none)
Explanation

Explanation/Reference:

QUESTION 34
You receive a Microsoft Outlook e-mail message that contains the following task outline:
     Establish corporate internal communications process.

     Find out the regional and country divisions' communications process.
     Plan communication methods, logistics, and timings.
     Establish regional and country communications to sales, marketing, and management.
     Find out the internal systems that must respond to the campaign.

     Create communications plan.
     Identify internal training requirements.
     Develop internal training.
     Organization of internal communications and training completion.

You need to incorporate the task outline into your project plan. What should you do?

A. Use the Bulk Import tool from the Project 2010 Solution Starters toolkit.
B. Copy and paste the task outline into the Task Sheet view of Project 2010.
C. Use the Task Inspector feature from Outlook.
D. Use the Import Outlook Tasks option.

Correct Answer: B
Section: (none)
Explanation

Explanation/Reference:

QUESTION 35
You attempt to print the task table and Gantt chart horizontally. However, the task names do not appear on
each printed page. You need to ensure that the task names are printed on each page. What should you
do?

A. Modify the settings in the Column Settings dialog box of the Task Name column.



B. Select the Task Name column and click Print.
C. Select the Task Name column and click Add to Timeline.
D. Modify the settings in the Field Settings dialog box of the Task Name column.
E. Modify the settings in the Page Setup dialog box.

Correct Answer: E
Section: (none)
Explanation

Explanation/Reference:
In Page Setup, on the View tab, Print first n columns on all pages.

QUESTION 36
The dates of your project are displayed in the long date format as Wed 09-01-28 12:33. You need to ensure
that the dates are displayed as 1/28/09. What should you do?

A. On the Format menu, modify the settings in the Layout dialog box.
B. On the File menu, modify the settings in the Options dialog box.
C. On the Format menu, modify the settings in the Text Styles dialog box.
D. Modify the settings in the Field Settings dialog box.

Correct Answer: B
Section: (none)
Explanation

Explanation/Reference:

QUESTION 37
You create a new Gantt Chart view. You need to copy the view to a different project. What should you do?

A. Use the Links Between Projects tool.
B. Use the Organizer tool.
C. Use the Save Views feature.
D. Use the Compare Projects feature.

Correct Answer: B
Section: (none)
Explanation

Explanation/Reference:
The Organizer is a dialog box that allows you to copy custom elements (incl. views, reports, tables, filters,
groups) between files, or between a file and the global template.

QUESTION 38
In the default Gantt Chart view of your Project Professional 2010 project, you need to display the following
information:
     Tasks that are not started.
     Tasks in progress.
     Tasks that have finished.
     Total remaining effort for each group of tasks.
What should you do on the View tab?

A. Select Group by Complete and Incomplete Tasks, and then add the Remaining Work field to the table.
B. Select Group by Complete and Incomplete Tasks, and then add the Work field to the table.
C. Select Group by Active v. Inactive, and then add the Remaining Work field to the table.
D. Select Group by Active v. Inactive, and then add the Work field to the table.

Correct Answer: A
Section: (none)



Explanation

Explanation/Reference:
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QUESTION 39
You need to view only the task name, start and finish dates, percentage of work completed, and a Gantt
chart. What should you do?

A. Create a custom filter and a custom view.
B. Create a custom table and a custom group.
C. Create a custom filter and a custom table.
D. Create a custom table and a custom view.

Correct Answer: D
Section: (none)
Explanation

Explanation/Reference:

QUESTION 40
You need to select a view that allows you to use the drag-and-drop feature on the resource assignments
and unassigned tasks. What should you do?

A. Select the Gantt Chart view, split the window, and then select the Resource Usage view for the details
pane.

B. Select the Team Planner view.
C. Select the Timeline view.
D. Select the Gantt Chart view, and then click Assign Resources.

Correct Answer: B
Section: (none)
Explanation

Explanation/Reference:

QUESTION 41
You create several new tasks by using the Manually Scheduled Task option. You need to automatically
calculate the start and finish dates for linked manually scheduled tasks. You need to achieve this goal while
retaining manually scheduled tasks within the project. What should you do?

A. Modify the values of Scheduled Start and Scheduled Finish.
B. Highlight the Project Summary task and use the Calculate Project feature.
C. Insert the task Constraint Type column and change the values for each task to the appropriate values.

Then, recalculate the project.
D. Use the Respect Links feature.

Correct Answer: D
Section: (none)
Explanation



Explanation/Reference:

QUESTION 42
You use Project Professional 2010 to manage a project. John, a team member, is over-allocated. You need
to identify the dates on which the over-allocation occurs. What should you do?

A. Use the default Leveling Gantt view.
B. Use the Team Planner view.
C. Use the Timeline view.
D. Use the Task Information dialog box.
E. Use the Task Details Form.

Correct Answer: B
Section: (none)
Explanation

Explanation/Reference:

QUESTION 43
You have an unscheduled, unassigned task in your Project Professional 2010 schedule. You identify an
available resource. You need to assign the task to the resource without scheduling the task. What should
you do?

A. Use the Replace feature in the Assign Resources dialog box.
B. Use the Add Resources function.
C. Use the Team Planner view.
D. Use the Calendar view.

Correct Answer: C
Section: (none)
Explanation

Explanation/Reference:

QUESTION 44
You are reviewing the task details of your project. You receive the following warning message: "This task
has resources assigned which are over-allocated." You need to be able to identify a possible resolution for
the over-allocated resources. What should you do?

A. Change the task type to Fixed Work, and then recalculate the project.
B. Change the task type to Fixed Units, and then recalculate the project.
C. Increase the task duration values for the task.
D. Use the Task Inspector tool.
E. Set the Level Assignments flag to Yes for the task, and then recalculate the schedule.

Correct Answer: D
Section: (none)
Explanation

Explanation/Reference:

QUESTION 45
You track all costs on your project. You need to track task-level airfare costs that do not depend on the
amount of work or duration of a task. What should you do?

A. Use a work type resource.



B. Create a custom field and capture travel costs at the project level.
C. Use a budget resource.
D. Use a cost type resource.

Correct Answer: D
Section: (none)
Explanation

Explanation/Reference:
The currency value of cost resources does not depend on the amount of work done on or the duration of
the task that they are assigned to.

QUESTION 46
Your project schedule contains both Work and Material resources. The resources are assigned to tasks
and are of either the committed or proposed booking type. You need to ensure that the project does not
contain over-allocated resources. Which feature should you use?

A. Clear Leveling
B. Assign Resources
C. Resource Pool C Share Resources
D. Level All

Correct Answer: D
Section: (none)
Explanation

Explanation/Reference:

QUESTION 47
John, a team member, will be absent from the team. A new team member, Mary, will take over Johns
remaining work. You need to update the project schedule to reflect the change. You also need to retain
Johns actual work. What should you do?

A. In the Assign Resources dialog box, use the Replace feature.
B. In the Resource Sheet view, delete John and add Mary.
C. In the Multiple Task Information dialog box, change the resource assignment from John to Mary.
D. In the Resource Usage view, rename John to Mary.

Correct Answer: A
Section: (none)
Explanation

Explanation/Reference:

QUESTION 48
Your project has some resources with rates that adjust over time. You need to ensure that project costs
automatically adjust for these resources. What should you do?

A. Create cost tables to include rates that activate on effective dates.
B. Change the resource availability settings to establish Units for selected dates.
C. Create resources that include fixed Standard costs, and then apply a rate variance per project task.
D. Create a named resource for each Standard hourly rate.

Correct Answer: A
Section: (none)
Explanation

Explanation/Reference:



QUESTION 49
Standard working hours are eight hours a day from Monday through Friday. You create a task of fixed units
and set the duration to 2 days. You assign the task to John at 100 percent. John wants to work only 50
percent on the task. You change Johns assignment units to 50 percent for the task. Which set of values
describes the specified task?

A. Duration shows 2 days; Work shows 0 hours
B. Duration shows 4 days; Work shows 16 hours
C. Duration shows 4 days; Work shows 8 hours
D. Duration shows 2 days; Work shows 8 hours
E. Duration shows 2 days; Work shows 16 hours

Correct Answer: B
Section: (none)
Explanation

Explanation/Reference:

QUESTION 50
You need to replace the resource assignment for an in-progress task. You also need to retain the Work,
Actual Work, Remaining Work, and Baseline data for the task. What should you do?

A. Use the Resource Name column drop-down list.
B. Use the Resource Pool feature.
C. Use the Team Planner feature.
D. Use the Level Selected feature.

Correct Answer: C
Section: (none)
Explanation

Explanation/Reference:

QUESTION 51
The first major phase of your project is scheduled for a duration of 45 days. However, you do not have task
information for other phases. You need to indicate that the duration of the entire project is 200 days. What
should you do?

A. Select the Project Summary Task option.
B. Select the Summary Tasks option.
C. Create a manually scheduled summary task.
D. Update the project calendar.

Correct Answer: C
Section: (none)
Explanation

Explanation/Reference:

QUESTION 52
You use bottom-up scheduling. You need to group four consecutive tasks in a major phase. You highlight
the four tasks. Which command should you use?

A. Outdent
B. Fill Down



C. Insert Summary
D. Move Task

Correct Answer: C
Section: (none)
Explanation

Explanation/Reference:

QUESTION 53
You need to ensure that you can view only the tasks on your projects critical path. What should you do?

A. On the Advanced tab of the Project 2010 options, select the Calculate multiple critical paths check box.
B. View the projects Gantt chart and apply the Critical group.
C. View the project's Gantt chart and apply the Critical filter.
D. On the Advanced tab of the Project 2010 options, modify the Tasks are critical if slack is less than or

equal to option.

Correct Answer: C
Section: (none)
Explanation

Explanation/Reference:

QUESTION 54
Your project contains several baselines. By mistake, you save one of your baselines in Baseline5. You need
to move Baseline5 to Baseline3 while preserving the baseline information. You also need to create a new
Baseline5 by using today's data. Which two actions should you perform? Each correct answer presents part
of the solution.

A. From the Clear Baseline window, click Clear baseline plan and select Baseline3.
B. From the Clear Baseline window, click Clear baseline plan and select Baseline5.
C. From the Set Baseline window, click Set interim plan and copy Baseline5 into Baseline3.
D. From the Set Baseline window, click Set Baseline and select Baseline3.
E. From the Set Baseline window, click Set Baseline and select Baseline5.

Correct Answer: CE
Section: (none)
Explanation

Explanation/Reference:

QUESTION 55
You have team members who work on one of the following shifts: Monday through Friday: 8 hours a day.
Tuesday through Saturday: 10 hours a day. Sunday through Wednesday: 12 hours a day. You need to
ensure that your project plan accommodates the different shifts. What should you do?

A. Create shift resource departments.
B. Change the maximum units for each resource.
C. Create three tasks, one for each shift.
D. Create a base calendar for each shift.

Correct Answer: D
Section: (none)
Explanation

Explanation/Reference:



QUESTION 56
Your project has some resources with rates that adjust over time. You need to ensure that project costs
automatically adjust for these resources. What should you do?

A. Create cost tables to include rates that activate on effective dates.
B. Change the resource availability settings to establish Units for selected dates.
C. Create resources that include fixed Standard costs, and then apply a rate variance per project task.
D. Create a named resource for each Standard hourly rate.

Correct Answer: A
Section: (none)
Explanation

Explanation/Reference:

QUESTION 57
You need to replace the resource assignment for an in-progress task. You also need to retain the Work,
Actual Work, Remaining Work, and Baseline data for the task. What should you do?

A. Use the Resource Name column drop-down list.
B. Use the Resource Pool feature.
C. Use the Team Planner feature.
D. Use the Level Selected feature.

Correct Answer: C
Section: (none)
Explanation

Explanation/Reference:

QUESTION 58
You need to ensure that you can view only the tasks on your projects critical path. What should you do?

A. On the Advanced tab of the Project 2010 options, select the Calculate multiple critical paths check box.
B. View the projects Gantt chart and apply the Critical group.
C. View the project's Gantt chart and apply the Critical filter.
D. On the Advanced tab of the Project 2010 options, modify the Tasks are critical if slack is less than or

equal to option.

Correct Answer: C
Section: (none)
Explanation

Explanation/Reference:

QUESTION 59
You manage several projects. Each project has shared resources and work distribution. You need to
ensure that you can adjust the workload for specific resources used across multiple project schedules.
What should you do?

A. Enable the Load Summary Resource Assignments option. Then, select the Level Resource function on
each project.

B. Open the individual schedules and use the Visual Reports option. Then, use the Resource Usage view
to manually modify resource Work.

C. Open a blank project and select Insert Subproject for each project schedule. Then, use the Level



Resource function for selected resources.
D. Open the shared Resource Pool for each project schedule. Then, use the Level Resources function.

Correct Answer: C
Section: (none)
Explanation

Explanation/Reference:

QUESTION 60
You want to print the Gantt Chart view of your project. You need to hide the Gantt chart legend. What
should you do?

A. Edit the view.
B. Edit the Bar Styles dialog box.
C. Edit the layout.
D. Edit the Page Setup dialog box.
E. Edit the Text Styles dialog box.

Correct Answer: D
Section: (none)
Explanation

Explanation/Reference:
In Page Setup, on the Legend tab, set 'Legend on' to 'None'.

QUESTION 61
You manage a project that specifies all constraint types to As Soon As Possible. You discover that one of
your key tasks is scheduled to end prior to the targeted finish date. You need to display the targeted finish
date on the default Gantt chart. What should you modify in the Task Information window?

A. Set the Deadline date field.
B. Set the Constraint date field.
C. Set the Finish date field.
D. Select the Mark task as milestone check box.
E. Select the Display on Timeline check box.

Correct Answer: A
Section: (none)
Explanation

Explanation/Reference:
Deadline dates don't usually affect task scheduling. They are used to indicate a target date you don't want
to miss, without requiring you to set a task constraint that could affect scheduling if predecessor tasks
change. A task with a deadline is scheduled just like any other task.

QUESTION 62
You need to view only the task name, start and finish dates, percentage of work completed, and a Gantt
chart. What should you do?

A. Create a custom filter and a custom view.
B. Create a custom table and a custom group.
C. Create a custom filter and a custom table.
D. Create a custom table and a custom view.

Correct Answer: D
Section: (none)
Explanation



Explanation/Reference:

QUESTION 63
The first major phase of your project is scheduled for a duration of 45 days. However, you do not have task
information for other phases. You need to indicate that the duration of the entire project is 200 days. What
should you do?

A. Select the Project Summary Task option.
B. Select the Summary Tasks option.
C. Create a manually scheduled summary task.
D. Update the project calendar.

Correct Answer: C
Section: (none)
Explanation

Explanation/Reference:
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